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Collecting Data and Importing it to ArcGIS 
 
 
From Mark Gregory’s in-service instruction on February 9, 2007 at Oklahoma State 
University 
 
 
First, using a Garmin GPS unit, go outside and collect data. This may be in the form of waypoints 
and/or tracks. 
 
 
 
Content Sections: 
 
Section 1 –Download and Install software to download GPS Data 
 
Section 2 – Run the DNR Program to Download GPS Data 
 
Section 3 – Starting ArcGIS software 
 
Section 4 – Editing Data within ArcGIS 
 
Section 5 – Adding labels to your map 
 
Section 6 – Downloading aerial photos 
 
Section 7 – Contact Information 
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Section 1 – Download and Install Software to Download GPS Data 
 
Google “DNR Garmin” to find software that will download your waypoints, tracks, etc. from the 
GPS unit onto your computer. The first address listed should be: 
 
DNR Garmin Extension for ArcView: Minnesota DNR 
Follow the link above and then click on the "DNR Garmin Discussion" link. ... If you have 
not done so, please click here to fill out our DNR Garmin user ... 
www.dnr.state.mn.us/mis/gis/tools/arcview/extensions/DNRGarmin/DNRGarmin.html - 17k 
- Cached - Similar pages 
 
OR use the following direct link to the Minnesota Department of Natural Resources site at: 
 
 http://www.dnr.state.mn.us/mis/gis/tools/arcview/extensions/DNRGarmin/DNRGarmin.html 
 
Selecting (clicking) either of the above links should place you at a web site of the Minnesota 
Department of Natural Resources. The web page should look as follows:  
 

  
Enter Keyw or  

search
 

 
A-Z List | Site Map | Contact the DNR | What's New? | Newsroom | Events & Seasons    

> MN DNR Home > About the DNR > Bureaus > Management Resources > Management 
Information Services > GIS > ArcView Resources >  

DNR Garmin Extension for ArcView 

Garmin GPS Extension 
Current Version: 
  ArcView Extension: 5.11  
  VB Program: 5.1.1 
  Build Date: 10/6/2005 
  Posted Date: 10/6/2005 
Works With: 
  Arcview 
  Arcmap (8.x, 9.x)   

 
 
This web site provides considerable information about the software program that you can use to 
download your Garmin GPS data to your computer. 
 
Scroll down the web page (near the bottom) until you see the link to Download Program.  

http://www.dnr.state.mn.us/mis/gis/tools/arcview/extensions/DNRGarmin/DNRGarmin.html
http://209.85.165.104/search?q=cache:Ds1hSZWdX0YJ:www.dnr.state.mn.us/mis/gis/tools/arcview/extensions/DNRGarmin/DNRGarmin.html+dnr+garmin&hl=en&ct=clnk&cd=1&gl=us
http://www.google.com/search?hl=en&rls=com.microsoft:en-us&q=related:www.dnr.state.mn.us/mis/gis/tools/arcview/extensions/DNRGarmin/DNRGarmin.html
http://www.dnr.state.mn.us/mis/gis/tools/arcview/extensions/DNRGarmin/DNRGarmin.html
http://www.dnr.state.mn.us/
http://www.dnr.state.mn.us/site_tools/azlist.html
http://www.dnr.state.mn.us/sitemap/
http://www.dnr.state.mn.us/contact/
http://www.dnr.state.mn.us/whatsnew/
http://www.dnr.state.mn.us/news/index.html
http://www.dnr.state.mn.us/events/
http://www.dnr.state.mn.us/index.html
http://www.dnr.state.mn.us/aboutdnr/index.html
http://www.dnr.state.mn.us/aboutdnr/bureaus/index.html
http://www.dnr.state.mn.us/aboutdnr/bureaus/mr/index.html
http://www.dnr.state.mn.us/aboutdnr/bureaus/mis/index.html
http://www.dnr.state.mn.us/aboutdnr/bureaus/mis/index.html
http://www.dnr.state.mn.us/mis/gis/index.html
http://www.dnr.state.mn.us/mis/gis/tools/arcview/index.html
http://www.dnr.state.mn.us/
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Download Program 
Full Setup of Version 5.1.1 for NT/2000/XP (10 MB) -- non-ArcGIS users should 
download the ArcGIS 9.x compatible version. 

o DNRGarmin 5.1.1 -- ArcGIS 9.x compatible (10/6/05) 
o DNRGarmin 5.1.1 -- ArcGIS 8.x compatible(10/6/05) 

 
Select (left-click) the Full Setup version of “DNRGarmin 5.1.1 –ArcGIS 9.x or ArcGIS 8.x.”   
 
A window should ‘pop-up’ on your monitor that has the title ‘File Download’. Text within the 
window is asking ‘Do you want to open or save this file?’  
 

 
 
Select Save the file.  
 
You will then be asked to indicate where on your computer system that you want the file to be 
saved. This location can be anyplace on your system where you have ‘write permissions’. A likely 
location is either in your home directory or in the Program File directory (which is generally 
located at C:\Program Files\ on your main, hard disk drive.  
 

http://files.dnr.state.mn.us/aboutdnr/bureaus/mis/gis/tools/arcview/extensions/dnrgarmin/dnrgarmin51setup_9x.zip
http://files.dnr.state.mn.us/aboutdnr/bureaus/mis/gis/tools/arcview/extensions/dnrgarmin/dnrgarmin51setup_8x.zip
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Wherever you place this file, it is essential that you remember where you saved the file. After the 
file has been downloaded, select Close on the pop-up window (below) to close that window. 
 

 
 
Now, navigate (through Windows) to the place (directory) where you saved the downloaded, 
program file. In Windows, the file should look like a file folder with a zipper.  
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Depending upon how your computer system is set up, there are several ways to ‘extract’ or 
uncompress this file. One way to extract this file is to Double-click on the folder, then select 
“extract all files” on the left side of the box. This will bring up an Extraction Wizard, such as this: 
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Follow the instructions for the Extraction Wizard and again indicate the location where you want to 
‘store’ or ‘save’ this program on your computer system. Most likely, this location would again be 
C:\Program Files\.  
 

 
 
 
Note that after the extraction has been completed, there is both a zipper folder and a ‘regular’ folder 
with the name ‘dangarmin51setup_9x (as seen at the bottom of the above graphic). 
 
 
IF double-clicking does not open up an extraction wizard and extract your program files, a second 
option may be available for you to extract the files. In this example you will need to right-click the 
‘zipper folder’ and select the ‘Extract All’ or ‘Extract with Winzip’ option (see the following 
graphic).  
 
Again depending upon what is available on your computer system, the previous Extraction Wizard 
(or something similar) should open on your system. In any event, follow the extraction instructions 
and indicate where you want to store this program on your system (such as noted above at 
C:\Program Files\ 
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And Finally, A THIRD option to extract the program files from the ‘zippered folder’ may occur 
when you double-click the zipper folder. In this example, your system may simply open up a new 
window that looks like this: 
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REGARDLESS of which of the above three methods you utilize to extract your program files, 
after the extraction process has been completed you will need to navigate (within Windows) to the 
folder where the ‘extracted’ files have been placed and double-click on the “dnrgarminsetup” icon.  
 

 
 
The following InstallShield Wizard should appear: 
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Follow the instructions of the setup launcher, including accepting the License Agreement. 
 

 
 
Accept the default location to install the software in the folder named C:\Program Files\dnrgarmin\ 
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When installation is complete the following window should appear: 
 

 
 
Select ‘Finish’ and the following Notepad window should appear: 
 

 
 
This ‘readme’ file provides some additional information; you can close the readme.txt file. 
 
The software that you need to download your GPS data from a Garmin GPS unit should now be 
installed on your computer. Unless you delete this program from your computer, you should NOT 
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have to download or install this software again, regardless of how many times you use the software 
or download data from you GPS unit. 
 
 
GO TO HOME PAGE 
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Section 2 – Run the DNR Garmin Program to Download GPS Data 
 
With the GPS unit off, attach the GPS cord, with one end connected to the back of the Garmin GPS 
unit and the other end to your computer. 
 
Turn the GPS unit ON. 
 
If the DNR Garmin software has been properly installed, there should be a DNR Garmin ‘shortcut’ 
icon (see below) on your desktop that will launch the DNR Garmin program whenever you wish to 
download Garmin GPS data.  
 

 
 
Double-click on the icon, making sure that BEFORE you double-click the icon and start the 
software that the GPS unit is ON and the cords between the GPS unit and the computer are all 
properly connected.  
 
The first time (and only the first time) that you start up the DNR Garmin software; a ‘pop-up’ 
window should appear that prompts you to “accept the default projection (UTM zone 15).  
 

 
 
Do NOT accept this projection. Instead, respond ‘NO’ and the following window will appear: 
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Select ‘No Projection’ from the above window. Again, these windows concerning default 
projections will only appear the first time after you initially install the DNR Garmin software. 
 
The following window for the DNR Garmin software should now ‘pop up’ on your monitor: 
 

 
 
If you have not properly connected your GPS unit or the unit is not turned on, the following 
message will appear: 
 

 



 14

Correct the problem. Then restart the DNR Garmin software so that it looks like this: 
 

 
 
Note in the lower left-hand corner of the window that the software is ‘Connected’ to you GPS unit. 
Depending upon what type of data that you collected with your Garmin GPS unit and that you now 
want to download from your GPS unit, select the Waypoint or Track menu at the top of the DNR 
Garmin window. Click on download.  
 

 
 
The points (or tracks if you use the Track Menu) from the GPS unit will download and a dialog box 
will pop up telling you how many records were downloaded. 
 

 
 
Note at the bottom of the above window that the GPS unit is still ‘Connected’ and that there were 
26 records downloaded from the GPS unit into the DNR Garmin software. Next, you will use the 
DNR Garmin software to convert the GPS data into a format usable by ArcGIS. If, however, you do 
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not want to transfer all of the Waypoints into ArcGIS (for example, because someone else 
previously collected points and you did not delete them when you started collecting your points), 
then you can select the unwanted points within the DNR Garmin window by clicking the number on 
the left side of the screen and then using the Delete button on the far left side of the screen. Below 
you will note that 7 waypoints have been highlighted and are ready to be deleted. 
 

 
 
After you have determined which (maybe all) of the Waypoints that you want to load into ArcGIS,  
select the File Menu at the top of the screen, then select the Save To option. 
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Note in the following window that 19 Waypoints are going to be saved to a File.  
 

 
 
At this point, you will be prompted  

1. Where to save the file, 
2. What name you want to call the file, and 
3. What file type you want the file to be. 

 
Where you want the file to be stored is entirely up to you and how you want to organize your data. 
 
Similarly, what name you use is your choosing, although I would recommend a file name that is 
very descriptive of the data it contains, 
 
And finally, the File Type that you will want to select should be ‘ArcView Shapefile (Unprojected” 
(*.shp) 
 
When you select SAVE, the GPS Waypoints will be saved in a format that can be added into 
ArcGIS. 
 
The procedures described above are for downloading Waypoints from a GPS unit and saving them 
in a format that can be used with ArcGIS is the same procedure for downloading and saving Tracks, 
with one exception. The exception to the procedures is that when you save the shapefile for Tracks 
data you will be prompted to determine what type of data you want to store 
 
Normally, you will want to store Tracks as a Line (which is the default value). You can, however, 
store tracks as Points or Polygons if you so desire. 
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Regardless of whether or not you are downloading Waypoints or Tracks, if you have ArcGIS 
running before you use the File Menu to save your data, the DNR Garmin has an option to save 
your data in an ArcGIS Shapefile format AND directly add your data into your current ArcGIS 
session. 
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If you select this option to save your data to a shapefile (with ArcGIS already running) you will 
then be prompted what name you want for the data file and where you want to save the file. 
 

 
 
The result will be that your ArcGIS session will now have your data already loaded into a map. 
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Section 3 – Starting ArcGIS Software 
 
If you have a Shortcut Icon for ArcGIS on your desktop, then double-click the ArcMap Icon. 
Otherwise, from Start menu on your computer Desktop, go to ArcGIS, then ArcMap.  
 

 
 
When ArcMap starts, you will be prompted with: 
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If you already have an existing ArcMap document, select “An existing map”, followed by selecting 
the existing map name. Otherwise (certainly the first time you start ArcMap) select “A new empty 
map” and then “OK”. 
 
IF you started ArcGIS before you saved the GPS data as an ArcView Shapefile Layer, the 
Waypoints or Tracks that you saved in the DNR Garmin software as an ArcView Shapefile Layer 
should show up in your ArcGIS Map Document. 
 

 
 
If you cannot see your data in the map window, but there is information listed in the layers or 
legend on the left side of your Map Document, click/select the Globe icon. This action will show 
the full extent of what you downloaded. Then you may just need to ‘zoom’ into the data in the Map 
Document in order to better view your data. 
 
GO TO HOME PAGE 
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Section 4 – Editing Data within ArcGIS 
 
Editing Data 
 
Mark’s Rule of Thumb for Editing - Edit as little as possible but as much as needed! 
 
To begin editing the features (Waypoints or Tracks) within an ArcGIS shapefile, you will first need 
to start the Editor Toolbar. The Editor Toolbar can be started by selecting the Editor Toolbar icon 
located near the top of the ArcMap document 
 

  
 
or  
 
by selecting the View Menu (at the top of the ArcMap document), then Toolbars (sub-menu) and 
finally the Editor option. 
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Either of the above two actions should result in the Editor Toolbar appearing in your ArcMap 
document window. Notice that all of the options on the Editor Toolbar are ‘grayed out’ – meaning 
that they are not currently available for use. 
 

   
 
Now you are ready to edit the Waypoints. 
 
To begin the Edit session, select the Editor Menu and then the Start Editing option: 
Once you have selected the Start Editing option, all of the options on the Editor Toolbar now 
become fully functional and are no longer gray. 
 

 
 
Make certain that the Target data set indicated on the Editor Toolbar is the name of the data set that 
you want to edit. 
 
For the remainder of these examples, we will use and edit the data set named Project Tracks. 
Therefore, the Target data set must be changed to the Project Tracks name. This change can be 
accomplished by selecting the ‘pull down arrow’ located just to the right of the current Target data 
set name and then selecting the Project Tracks data set name. 
 



 23

 
 
Note that when you are in a current ‘edit session’ and your cursor is located over your map, the 
cursor should change into a black arrowhead shape. If your cursor does not change into the 
arrowhead shape when placed over the map, select (left-click) the ‘Edit tool’ or the black arrowhead 
icon on the Editor Toolbar. 
 
To edit a feature (track, waypoint, etc.) in your map, double-click the feature with the arrowhead 
shaped cursor. When selected, line features should change color to a light/bright blue color and with 
all points on the line should turn into a green box shape. 
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If you want to move a point (called a vertex by ArcGIS), make certain that the line is highlighted 
with the vertices represented as green boxes, then place the cursor over the vertex you want to 
move. When the cursor is located over a vertex, the cursor should change from an arrowhead shape 
to a ‘four-pointed star’ shape. Left-click and hold the point, move the point wherever you wish, and 
then release the left-click. That vertex on the line will now be moved into a new location and the 
shape of the line will be changed.  
 
To delete a vertex, repeat the above process so that the cursor turns into the ‘four-pointed star’ 
shape when located over the vertex that you want to delete; then (with the ‘four-pointed star’ shape 
still visible, right-click and a window should appear that will allow you to select the ‘Delete’ option.  
 
If you want to add a new vertex to a line, make sure that the line is highlighted, then right-click at 
the location along the line where you want the new point to be located. The new location cannot be 
the same location as an existing vertex and the arrowhead shape of the cursor should now have a ‘+’ 
symbol at the point of the arrowhead. Once the ‘+’ symbol appears, you can right-click and a 
window will appear that will allow you to ‘Insert Vertex’. 
 
You can also move an entire line by highlighting the line (either single-clicking or double-clicking 
it), then left-click and hold the line, move the line to its new location, and then release the left-click. 
The entire line will be moved. Similarly, you can delete a line by double-clicking it and then 
selecting the ‘Delete’ button on your computer keyboard.  
 
If you want to add an Attribute Field to your table, so as to serve as a Label on the map, you must 
NOT be editing the data set at the time you can the attribute field. Consequently, you may need to 
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‘Stop/Save Edits’ from the Editor Menu used above to ‘Start Editing’. Your edits are not saved 
unless you select Save Edits prior to quitting the Edit session.  
 
Adding an Attribute Field 
 
To add an Attribute Field to a data set, you need to Open the Attribute Table associated with your 
data set. This is accomplished by right-clicking the name of the data set in the Legend or left-hand 
box of the ArcMap window, and then selecting the Open Attribute Table option. 
 

 
 
The Attribute table should then appear similar to the following: 
 

 
 
In order to add a field to the attribute table, right-click the Options button at the bottom of the table, 
and then select the Add Field option. 
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Fill in the Name of the attribute (in this example, TrackName) and the Type of data (probably Text). 
 

 
 
Once this action has been accomplished, select ‘OK’ at the bottom of the Add Field window. 
 
Adding an Attribute Value to a Feature 
 
The previous actions only added the attribute field to you data set. In order to actually add a value 
or name for a specific track, however, you must again be in an active Edit Session. So, select the 
Editor tool on the Editor Toolbar, and Start Editing the data set. 
 
You can select a specific track in your data set by left-clicking the feature (track) in the Map or by 
left-clicking the first (far left) button on a row in the table. In either case, the track AND the row in 
the table should BOTH be highlighted in the same light/bright blue color. Once you have the feature 
selected for which you want to provide an attribute value, left-click in the table the cell or area that 
represents for the attribute name (again in this example, TrackName) and the selected row intersect, 
and type in the name you want to use as a label for that track. 
 



 27

 
 
In the above example, the value “School Path” was added to the TrackName field for the track 
highlighted/selected in the Map and the table. 
 
As before, when all editing, labeling, etc. has been completed, select the Stop Editing option under 
the Editor Menu; respond ‘Yes’ if prompted about ‘Do you want to save your Edits’ (assuming you 
do want to save them). 
 
GO TO HOME PAGE 
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Section 5 – Adding Labels to Your Map 
 
In order to add labels to the features in your map, you must first have a field in the attribute table 
and then have values in that field to be used as the map labels. In the above example, we have 
created an attribute field named TrackName and have added a value to that field for only one 
feature (School Path). You can make the name “School Path” appear on your map with the 
following steps: 
 
Either double-click the name of the data set in the map Legend (in this example, Project Tracks),  
 
OR 
 
right-click the name of the data set in the map Legend and select the Properties option from the 
menu that will appear. 
 

 
 
Either action (double-clicking or right-clicking with the Properties option) should result in the 
following Layer Properties window: 
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Once the Layers Properties window is open, select the Labels tab at the top of the window: 
 

 
 
Next, use the pull-down menu near the center of the window to select the Label Field name that you 
want to use as the Labels in your map (in this example, TrackName). 
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Click “OK” to close the Layer Properties window. 
 
Right-click the data set name in the map Legend, and select the Label Features option. 
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The Labels should now appear next to the appropriate features on the map: 
  

 
 
 
GO TO HOME PAGE 
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Section 6 – Downloading Aerial Photography 
 
There are three locations within Oklahoma that have aerial photography that can be directly loaded 
or added into ArcMAP. OSU and OU as well as the Oklahoma Geographic Information Council 
have web sites that allow aerial photography to be downloaded on a county basis. Of the three 
locations, the OU site is probably the easiest from which to secure the aerial photography. Only the 
Oklahoma Geographic Information Council site, however, has the most recent (2006) photography. 
 
OU site 
 
The data on the OU site are actually stored on the Oklahoma Geographic Information Council site, 
but are more easily accessed through the OU site. Therefore, use your Internet browser to navigate 
to Center for Spatial Analysis at http://www.csa.ou.edu/ 
 
Select the ‘DATA, PRODUCTS & TOOLS’ tab on the left side of the web page; and then select the 
‘OK DATA WAREHOUSE’ option (http://geo.ou.edu/DataFrame.htm). 
 
Select the ‘IMAGE DATA’ tab on the left side of the page; then select the ‘BY MAP’ option. 
 
You should then be presented with a map of Oklahoma, indicating the County outlines. 
 
Select the County for which you want data. You will then be presented with a detailed map of the 
selected county, mainly showing the road network. 
 
Select (left-click) anywhere within the county boundary, you should then be presented with a web 
page that has a title near the top of the page that reads “NAIP County Mosaic Orthophotography for 
XXXX County” (where XXXX is the name of the county you previously selected). 
 
There are several different data sets and types of data that are available to be downloaded from this 
page. The county-wide Aerial Photography that you want, however, is located near the top of the 
page, just beneath the above mentioned title. 
 
Located just below the title mentioned above, you should notice three headings (2003, 2004 and 
2005). These headings represent the aerial photography that was taken during each time period 
indicated in the heading. The actual files that you want are located by the ‘hot links’ labeled 
**SID** and **SDW**. Determine which year that you want, and then select (left-click) the 
**SID** link and download the file. When that download is complete, then select (left-click) the 
**SDW** link to download that file. You need to download both the **SID** and **SDW** files. 
The **SID** file is quite large and depending upon the speed of your internet connect may take a 
considerable amount of time to download. The **SDW** file is very small and will download 
almost immediately. If left-clicking does not download the file (particularly for the **SDW** file), 
then right-click the file and select the option to “Save Target As”. 
 
Save the files on your hard disk and remember where it is saved.  
 

http://www.csa.ou.edu/
http://geo.ou.edu/DataFrame.htm
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In ArcMap, click on the Add Data Layer button (plus sign over the yellow square) located near the 
top of the ArcMap window. You will then need to navigate through your disk system to the location 
where you saved the above downloaded files. Select the file with the name that ends in .sid. 
 
An aerial photograph for the entire county should now be viewable within ArcMap. And if your 
GPS data is located over the save area, then both the GPS data and the aerial photography should be 
viewable at the same time 
 
If you only see the aerial photography and not the GPS data, make certain that the GPS data is listed 
first in your ArcMap legend (the window on the left side of the ArcMAP document) and that the 
aerial photography is listed last in the legend. You can change the order of the data sets in the 
Legend by left-clicking and holding the name of the data set in the Legend and then dragging the 
data set name to another location or order in the Legend. 
 
Oklahoma Geographic Information Council site 
 
If you want to download the 2006 aerial photography for a county in Oklahoma, you will have to 
access that data from the Oklahoma Geographic Information Council site. All years of aerial 
photography data are available at this site, although as mentioned above, most feel that it is easier to 
download the data from the OU site. 
 
Use your Internet browser to access the Oklahoma Geographic Information System web site 
(http://okmaps.onenet.net/). From the home page, select GIS Data, then Digital Orthophotography. 
Finally, you can download the files on a county basis from the link at the bottom of the Digital 
Orthophotography page or ftp://ftp.okcc.state.ok.us/gis/County. From there, choose the year that 
you want (such as 2006) and then select the County that you want (such as Payne). Once you get 
within the county folder for the year you want, then you will have to select the individual files that 
you want (such as the .sid or image file) or you can download the .zip (compressed) file and then 
uncompress it on you own computer.  
 
Again, once you have the data downloaded and possibly uncompressed (if you downloaded the .zip 
file), then you can load the aerial photography into ArcMap by using the Add Data Layer button 
(plus sign over the yellow square) located near the top of the ArcMap window.  
 
 
GO TO HOME PAGE 
 
 

http://okmaps.onenet.net/
http://okmaps.onenet.net/digital_ortho.htm
ftp://ftp.okcc.state.ok.us/gis/County
ftp://ftp.okcc.state.ok.us/gis/County/2006/
ftp://ftp.okcc.state.ok.us/gis/County/2006/Payne/
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Section 7 – Contact Information 
 
Mark Gregory 
271 Agriculture Hall 
Natural Resource Ecology & Management 
Oklahoma State University 
Stillwater, OK 74078-6028 
405-744-9603 
405-744-5269 (fax) 
mark.gregory@okstate.edu 
 
 
 
GO TO HOME PAGE 

mailto:mark.gregory@okstate.edu
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